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INTRODUCTION: WHY USE A TEMPLATE? 

When you started to work with ArchiCAD, you installed the software and began to learn 
the tools and methods. You may not have thought much about the initial "blank" file that 
appeared, ready for you to start to work. In that file, there existed certain layers, 
linetypes, fills, composites, materials etc. (collectively called Attributes) as well as a 
basic structure (stories, views, layout masters and layouts). That file was created from a 
startup "template".

There is a startup template file built into ArchiCAD by Graphisoft. You can access it by 
doing a New and Reset (hold down the ALT or OPTION key and choose File menu / 
New and Reset). The basic settings in this file are workable, since they include a variety 
of attributes and some structure, but will need to be augmented by the user in order to 
successfully produce a model and construction documentation.

Graphisoft provides in many regions a localized template to create a new project when 
you choose New File from Template. For example, in ArchiCAD 11 in the United States, 
that template is called ArchiCAD 11 Template.TPL. It has more attributes (materials, 
fills, layers, etc.) and a more developed structure than the "basic" template, however it 
still leaves a lot of setup work for individual users. This is understandable, since 
Graphisoft chooses to give a base on which to build, one which is easily understood 
(simplified) and relatively universal (most everything will be relevant for most users).

The alternate option: New file / Use Current Settings will carry forward (from the last file 
opened or worked on) the Attributes with minimal structure. While Attributes such as 
Layers and Layer Combinations, Materials, Fills, etc. will be inherited, the structure will 
be minimal, with almost no Views or Layouts to start out. This is a far inferior approach 
to starting a new project with a template, since you will have to set up so much from 
scratch.

Once you have worked with ArchiCAD for a while and produced several projects, you 
may have developed your own template, either explicitly or simply by your work 
process. It will have the attributes you have found that you need, be personalized with 
your title block, and be a familiar environment in which to design. To create a template 
explicitly is simple: take any project that you are satisfied with, and save the PLN as a 
template file (File menu / Save As / Template - TPL file). Then, when you start up a new 
project, you may choose New File from Template, and browse for the TPL file you 
saved. After opening it, ArchiCAD will rename it Untitled, so you will not inadvertently 
overwrite the template, and will prompt you when for a name and location when you 
Save the PLN file.

If you save an entire project (building and all) as a TPL file, of course you will need to 
delete the old building before starting a new one. It makes sense to do this BEFORE 
saving as a TPL, since otherwise you will have to do this every time you start a new file. 
However, you don't have to delete everything: you may retain anything you might use in 



future projects, including Elevation and Section markers which define corresponding 
Views that are placed onto Layout Sheets. In your new project, you will simply need to 
move these markers into the appropriate locations for the new building. You will see that 
those Elevations and Sections are still (already) placed on Layouts and will happily 
update when you request them to show the new design. Similarly, detail drawings you 
use in multiple projects can be retained in the TPL file so that you do not have to draw 
them again or re-import them.

This basic approach is the key to the ArchiCAD MasterTemplate. There is a tremendous 
amount that can be set up ahead of time in a robust template file, to save time and 
improve consistency within and between projects. ArchiCAD resellers and consultants 
have traditionally offered services to set up office standards and templates, and some 
have published or sold their templates. In the U.S., there have been templates from Rex 
Maximilian (MaxATS), Eric Batte (Standardized Template System 
http://www.getstandardized.com), and AEC Infosystems 
(http://www.aecinfosystems.com). We are indebted to these people and companies, as 
well as to many of our own local users such as Van Hohman (Fonda-Bonardi and 
Hohman Architects), Tamir Barelia, Vincent Moretti, Erika Epstein and others who have 
shared their ideas with us at ArchiCAD User Group meetings over the years. 

We have attempted the bold task of synthesizing all of our years of experience working 
with the program (Eric has 18 years, Scott has 12 years) with all the bright ideas we 
have seen, to create the best startup template possible: the ArchiCAD MasterTemplate. 

We set it up, so you don't have to.



PURPOSE OF THE ARCHICAD MASTERTEMPLATE 

• A starting environment that allows a streamlined workflow, with the objective of 
getting better work out more quickly with less frustration and fewer errors. 

• Enhances both the modeling & construction document process.

• After initial use that includes first time setup, never again waste time recreating a 
project file or settings. 

• Create a repeatable and reliable office standard, thereby reducing errors. 

• Make the best use of AC11’s automated features. 

• Foster office standardization. 

• Designed to teach at the same time as providing a working framework. 

• What the template is NOT: 
o one-size-fits-all
o perfect without any changes
o resistant to improvement

The ArchiCAD MasterTemplate is fully customizable, designed to be used out of box 
with minor ‘fill in the blanks’ items.



TEMPLATE ORGANIZATION AND STRUCTURE 

It may be useful at this point to describe architectural projects designed and 
documented in a CAD or BIM system as being comprised of four inter-related schema:

Geometry: the actual form, shape and materials of the building design; also the 
geometry projected into standard orthographic drawings (e.g. plans, sections, 
elevations, details)

Annotation: the text, labeling, call-out markers and dimensioning that describe the 
building in each drawing

Attributes: the line-types, wall types, layers and layer combinations, fills, materials that 
are used to depict and control the appearance of geometry on the drawings

Structure: the relationships

• between annotated, attributed geometry and actual drawings (e.g. View 
definitions of layer combination, scale, model view options, etc.),

• between each drawing and other related ones (e.g. plans to sections to 
elevations and from any of these to detail drawings), 

• between elements in the design and the schedules used to tabulate and 
summarize them,

• between the drawings and the layout sheets, and

• between drawings or layouts and various output sets (e.g. print or plot sets, 
submissions of files to consultants, etc.)

A template in a CAD or BIM system in general does not contain an actual building 
design, nor the annotations of any particular building. However, it is best if it contains all 
of most of the attributes needed to describe buildings in the system, plus as much 
structure as can be set up ahead of time. This will minimize the work getting each 
project started, guarantee consistency between projects as well as within each project, 
and streamline the workflow in a variety of ways.

The ArchiCAD MasterTemplate contains both Attributes and Structure preset and ready 
to go.

• Optimized layer naming system 

• Extensive layer combinations 

• Coordinated Model View Options 

• Predefined Autotext fields ready for data entry pre-placed onto layout sheets. 

• Pre-defined Views in View Map 



• Pre-defined Master & Layout Sheets

• Pre-placed Drawings on Layout Sheets. 

• Detailer template and modules fully integrated 

• Example penset systems to be considered in evaluation of your own system 

• Integrates the best free third party library parts 

• Included modified interactive schedules 

• Sample profiles for rafter tails, street roadwork, etc. 

• Typical project folder structure - a place for everything, everything in its place 

WHAT'S INCLUDED 

The ArchiCAD MasterTemplate is made up of the following:

• ArchiCAD MasterTemplate.TPL (a blank template file you will customize, then 
use to start your next project)

• MasterTemplate SAMPLE.PLN (an example demonstration project) as well as 
MasterTemplate SAMPLE REMODEL-ADDITION.PLN (an example of a 
remodel project)

• MasterTemplate LIBRARY (a folder containing the supporting library, modules, 
preferences and favorites)

• AMT PROJECT FOLDER (a sample folder structure for your project data) 

• AMT DOCUMENTATION (this manual, the QuickStart Guide, and other 
supporting files) 



DOWNLOAD AND QUICK TOUR OF 
THE ARCHICAD MASTERTEMPLATE 

Please follow the instructions supplied with your purchase to download the template 
files. They are supplied as a single large Zip archive file (or multiple smaller Zip files), 
and will need to be extracted or expanded into a folder somewhere on your workstation.

Place this AMT folder wherever convenient for now, such as on your Desktop. Later 
we'll discuss strategies for where to store your template files, which will vary depending 
on whether you are working alone or setting this up for a whole office.

Start by opening the MasterTemplate SAMPLE.PLN file to see how we have set up 
and organized this system. We assume that you have a basic knowledge of project 
navigation and the menu structure within ArchiCAD 11. 

• NOTE: Warning messages may appear when the sample file is opened the first 
time. 

• Normally a Library Manager dialog will not appear when you load the file. If the 
Library Manager dialog comes up while loading, or you get a Library Loading 
Report:

or



you will need to manually load the MasterTemplate Library, the MasterTemplate 
SAMPLE PROJECT LIBRARY and/or the ArchiCAD Library 11 folder.

• In the Library Manager dialog that pops up while loading (or after opening the file 
and getting a Library Loading Report as above, choose File menu / Libraries and 
Objects / Library Manager), navigate to the location where the template files have 
been downloaded and extracted, highlight the MasterTemplate Library folder on 
the left side, then click the "Add" button:



When all libraries have been "found", click the Done button to proceed.

• NOTE: ArchiCAD normally will find the MASTERTEMPLATE LIBRARY folder 
without prompting as long as you leave it next to the MasterTemplate 
SAMPLE.PLN file in the AMT folder. Similarly, it will find the ArchiCAD Library 
11 folder, unless you have moved or changed the path.

• Any other warning messages may safely be ignored for now - keep clicking OK or 
Skip or the Close button on any warning dialog or report window.



THE VIEW MAP

Once this simple file is open, if you glance at the Project Map, you will see just a few 
stories, elevations, sections, worksheets, etc. It is, after all, just a small two story house. 

However, when you look at the View Map, you will discover there are close to 200 
predefined Views, grouped into four major categories: 

When you open the main View folders to the next level, you will see additional 
subgroupings: 



Some of these (e.g. Design Sketches or Web Downloads) are empty folders, others are 
folders that contain preset views, and some are "Clone" folders (more on that later). We 
suggest you explore by opening up these folders and double-clicking each View to see 
all the different ways the project information can be represented. The beauty of this 
system (and ArchiCAD itself) is that most of these Views will show appropriate 
information without any effort on your part: simply model the building, and the View will 
be ready for you to annotate. 

NOTE: The TRASH - RECYCLE BIN folder is available for you to place anything you 
don't need but want to save for later use, such as Detail Folders while you are in early 
design. 

As you activate each View, ArchiCAD will display the Layer Combination, Scale and 
Model View Option in use. Notice that the Layer Combinations and Model View Options 
(MVO) have similar names. Each Layer Combination is unique, while a number of the 
MVOs are essentially the same; we have opted to create additional (duplicate) MVOs to 
make it easier to correspond the right MVO with each Layer Combo. 

- show graphic here for View Settings -



LAYERS, LAYER COMBINATIONS & MODEL VIEW OPTIONS

Open up the Layer Settings dialog and explore the Layer naming conventions. 

(should be 
replaced with more current screen-capture) 

You'll see that we followed the common convention of a single letter for the main 
category followed by subcategory groupings, but have broadened it from the AIA or 
NCS (National CAD) standards. There is little reason to use just 4 letter groups, since 
layer names can be longer now than they used to be, so we use easily readable 
phrasings.

AMT uses the Extension for grouping layers with common purposes (e.g. 3D for model 
elements that will also be seen in drawings, 2D for annotation seen only in drawings, 
along with some specialized designations). 

One special innovation is the use of the "U" prefix (as opposed to A, C, E, etc.) for 
elements that are only seen in ONE drawing. These can be of any type, 3D or 2D, text 
or model, as long as they are only to be seen in one construction document. For 
example, the Electrical Plan will include some objects (receptacles, switches, etc.), text, 
labels and perhaps dimensions that are only on that drawing. These elements go on the 
U | ELECTRICAL layer. This convention makes it easier to decide which layer to put 
things on. 

For visual clarity, AMT uses vertical separators ( | ) rather than dashes ( - ) to break up 



phrase groups in layers, layer combos, MVOs and other lists. We feel it makes it easier 
to scan the lists. 

NOTE: A separate layer set is available for compatibility with industry standards such as 
the AIA, National CAD Standard (NCS) or the Uniform Drawing System (UDS). These 
layers are set up in the NCS-UDS version of the template (otherwise identical to the 
base MasterTemplate), as well as in an Attribute Manager file that can be swapped in 
easily at any time. A description of how AMT approaches layer standards compatibility 
is given in one of the appendixes.

Layer Combinations have been defined for all standard drawings as well as for 
modeling, detailing and other dedicated activities. Note that as you activate each Layer 
Combo, layers that are hidden are also LOCKED, which allows them to be omitted 
when you are using popup palettes to choose which layer to place an element. More on 
that later. 



THE LAYOUT BOOK

Explore the Layout Book as well. The simple structure of the Layout Book (see graphic 
below) includes the skeletal form that can grow to handle projects of any arbitrary size. 
Open up the subset folders as well as the Masters and explore the layout sheets to see 
what has been set up. 

Pay particular attention to the Title Page layout, on which there are a multitude of 
Autotext entries placed directly on the sheet. Experiment by opening up the File menu / 
Project Info command and filling in some of the data there, then return to the Title layout 
to view the result. 

NOTE: As a convenience, uninitiated entries in the Project Info have multiple asterisks 
(e.g. ***PROJECT NAME***) to make it easy to spot information that has not been
initialized or filled in. 

Remember, all that is in this sample file is in the actual ArchiCAD MasterTemplate, 
which is fully customizable to suit your needs. 

For now, our brief tour of the sample file is done. We will point you to this file at other 
points in the manual to illustrate other features and techniques. 



SETUP AND CUSTOMIZATION

• ArchiCAD MasterTemplate Folder location. 

• Projects Folder structure and location

• Template Support Files & Folder 

• WHERE TO SET UP THE ARCHICAD MASTERTEMPLATE 

For sole practitioners, we suggest that you set up an ArchiCAD Office Standards (AOS) 
folder inside your Jobs folder (where you keep all current projects). In a multi-person 
office, the AOS folder should be located on your server in a location accessible by all 
team members. 

When you downloaded and extracted the template files, you placed them on your 
Desktop or some convenient place. Keep the original download files safe as a backup 
or reference, then place a copy into your ArchiCAD Office Standards folder. 

The AOS folder should contain the AMT (MasterTemplate) folder, as well as other 
support files used in your office for working in ArchiCAD, such as custom libraries, 
collection of detail drawings, boilerplate PDF's and Word files for placement into 
construction documents, etc. 



• CUSTOMIZE YOUR MASTERTEMPLATE

You will need to customize the ArchiCAD MasterTemplate to have your firm's 
information in the title block and on the Title sheet. Since the AMT is an 
ordinary ArchiCAD PLN project file saved as a TPL template file, you can modify 
anything else you wish, right away or at a later date. 

First, you'll need to duplicate the original AMT file to create your personal copy. Using 
Windows Explorer or the Finder (rather than from inside a dialog box while 
running ArchiCAD), navigate to the AMT folder. Select the ArchiCAD 
MasterTemplate.TPL file and right-click to Copy, then immediately afterwards right-click 
in the same folder and Paste. You will now have a duplicate AMT file. Rename it Office 
MasterTemplate.TPL or ABC Architects MasterTemplate.TPL or anything you wish. 
You now have a custom template you will make specific to your office. 

Whenever you wish to customize or revise your Office MasterTemplate, you will need to 
open it up differently than you when you start work on an actual project.  Start ArchiCAD 
and choose Open File / Browse for File (or with ArchiCAD already running, go to the 
File menu and select Open). In the Open File dialog box, choose as the file type (from 
the popup) "TPL Template File" (or "All Files"), and navigate to and select your new 
custom Office MasterTemplate.TPL file (or whatever you named it). When opened in 
this fashion, you will have access to revising and resaving it most easily. You will see its 
file name at the top of the screen, rather than Untitled. 

NOTE: This is important - if you see Untitled at the top of the screen instead, 
we suggest you close the file, and open your Office 
MasterTemplate.TPL again in exactly the way just described, so you have 
proper access to the file. 



• CLEANING UP ANY WARNING MESSAGES 

Normally a Library Manager dialog will not appear when you load the file. If the Library 
Manager dialog pops up, you will need to tell ArchiCAD where to find the appropriate 
libraries. ArchiCAD will find the MASTERTEMPLATE LIBRARY folder without prompting 
as long as you leave it next to the Office MasterTemplate.TPL file in the AMT
folder. Similarly, it will find the ArchiCAD Library 11 folder, unless you have moved or 
changed the path. 

However, if you need to show the Library Manager where either of these folders are 
located, you may use the tabs at the top to select Local/LAN and navigate to and 
select the appropriate folder, then click the ADD button to add it to the list of "known" 
libraries. (If you have any problem doing this, please email BCG or contact your 
ArchiCAD reseller for guidance.) This will be remembered the next time you open or use 
the AMT file. 

One of the messages you will get the first time you open AMT will refer to missing 
Hotlinked Module files. 

Since these support files are not found in their original location (on the computer where 
they were created), you will need to help ArchiCAD find their current location on your 
workstation or network. After you finish opening AMT, go to the File menu and select 
External Content / Hotlink Manager. 



Click in the white space below the short list of files, so that none are selected. 

Then click the button Read All From... and navigate to the AMT folder, select the AMT 
LIBRARY folder and click OK; ArchiCAD will search through the Library folder and find 
the MODULES folder inside it.



You will then see that the Hotlinks status has changed to "OK, Path Changed". 

Click the OK button.

Now all the Hotlinked Modules (HLMs) will "know where they live". We'll be exploring 
these HLMs later on in this manual. You should only have to do this process once, as 
this will be recorded by ArchiCAD in the template file and in copies made from it.



• ENTER YOUR INFO IN THE PLACEHOLDERS 

AMT contains ‘place holders’ for your company information and other boilerplate text. 
The placeholders are identified as framed text boxes with grey backgrounds. These 
may be edited in the Title Block area of the Master Layouts, or directly on the Title 
Sheet and other Layouts. 

Systematically go through the various Master Layouts that you intend to use (you can 
ignore Masters with sheet sizes that are not relevant) and fill in your company 
information and logo to "make it your own." 

TIP: To simplify a transition from another CAD system, you may import your 
old title block as a drawing (File menu / External Content / Place External 
Drawing…) on either a blank layout or a Master, then explode it (Edit menu / 
Reshape / Explode). 

Carefully delete anything you don't need from your old title block (for 
example, graphics and Autotext that are already included in the 
MasterTemplate). Get rid of placeholders or graphics from the Master that 
you will be replacing. Then move the desired content into position onto the 
Master. 

For safety, you may want to try this first on a copy of a Master. To copy a 
Master Layout, drag it into a new position in the Master list while holding 
down the Control key (PC) or Option key (Mac). To work on the new copy, 
double-click it in the Master list. 

Once you have the Master copy looking the way you like, you may Select All 
and Copy, then go the original Master, Select All and Delete, then Paste. 
Delete the Master copy after you verify that the Master is working correctly. 

Flip through the actual Layout pages in the template, and anywhere there is a 
placeholder grey box, fill in what you can. Remember that whatever you place into your 
template will save you time in every project, and will always be editable as needed. 

After you have entered all of your office and boilerplate information, Save your work. 
ArchiCAD will automatically overwrite the TPL file with the latest version, as long as you 
opened it up the way we instructed above. 

Once you have customized your standard office template you will follow the instructions 
below to start each new project. If you would like to edit or rework your template, follow 
the special instructions above to open the Office MasterTemplate.TPL file for revisions. 



STARTING YOUR OWN PROJECTS

Start up ArchiCAD and choose New File / Use a Template; or if ArchiCAD is already 
running, choose File menu / New… then specify Use a Template. The first time, you'll 
need to browse for your Office MasterTemplate.TPL, the one you have modified to 
include your office standards. 



Any subsequent time, it will be simpler: you will see it's name highlighted in the recent 
Templates popup list. 



As you start each project, you will want to go through the File menu / Info / Project Info 
and fill in whatever fields you can: 

Press down on the triangle to popup a text entry area which supports multiple lines. 
Remove the asterisks (***), which are included simply to make it easier to see which 
fields have not yet been entered. Some entries may not be known yet, or not be 
appropriate to this project, and you may leave them unchanged. You can return here 
to fill in this info at any time, and it will update on the Title Block and on the Title Sheet. 

The file will initially be labeled ‘Untitled’, and require you to ‘Save As’ with your desired 
project name. Make sure when you "Save As" to choose PLN format (ArchiCAD 
Solo Project), and name as desired (e.g. 07123 SMITH HOUSE.PLN). Save the PLN 
into its own project folder (e.g. 07123 SMITH) inside your Jobs folder. 

TIP: The ArchiCAD MasterTemplate folder contains a sample MT PROJECT 
FOLDER. This folder has many subfolders ready to hold typical project 
information. Look in the PROJECT FOLDER section later in this manual for 
more guidance on its use and customization. 

You are now ready to begin laying out your building or site. Be sure to review and adjust 
the number of stories and floor-to-floor elevations as needed. This can be done in the 
Story Settings Dialog Box under the Design Menu. See the section for SEA LEVEL OR 
PROJECT LEVEL for guidance on how to move the building elevations in the Story 
Settings to match actual survey elevation data if desired.

Construct the model and site as you normally would. You will have to adjust the 
locations of the pre-placed section and elevation markers. There is a pre-drawn slab in 



MasterTemplate that represents in a simple way the adjacent exterior grade. You may 
need to adjust it's vertical elevation to account for the relative relationship between 
grade and the first story level or project zero. You can also discard this slab and replace 
it with one or more Mesh and/or Slab elements when you are ready to represent 
topography in a more detailed manner.

Depending on the size of your building, additional adjustments may be required for the
boundaries and locations of the pre-placed drawings in the Layout Book. 



CRITICAL THINGS TO KNOW ABOUT WHEN 
USING THE TEMPLATE

This template is set up so that when used correctly, Views of your model will be 
automatically generated and placed as Drawings within predefined Layout Sheets, 
placed in a way ready for slight repositioning and output. Using the template correctly 
means good project setup, modeling, and most importantly, making sure entities or 
elements are placed on the correct layers. As an example, if you place an exterior wall 
on a layer intended to receive a roof, the wall will not display correctly, and the resulting 
Views will misrepresent the desired outcome. Therefore it is critical that careful 
attention is paid to which layers modeling and annotation items are placed upon.

Layer Combinations and Layer Names have been carefully pre-set to achieve this, 
however occasion may arise where slight modifications to either of the mentioned Layer 
controls are necessary. Layer Combinations must be properly updated following 
standard procedure when new Layers have been added, or existing Layer names are 
changed.

TIP: In the Layer Settings Dialog Box, and with the added Layer selected in the right 
side column, start at the top of the Layer Combination list on the left, select each in 
succession and set the visibility, mode, interaction and locking attributes one at a time. 

Another important issue to be aware of is file contamination. This generally occurs 
when elements are copied from legacy projects (prior to using the MasterTemplate), 
and pasted into the MasterTemplate. For example, there may be a well designed 
window system that exists in an earlier project, with the complex set of parameters 
already defined. The instinctive move is to copy the wall containing the window and 
paste it into the new project. The issue with this is that all attributes attached to those 
elements will be pasted in as well, including line types, materials, fills and layers.

When a user desires to paste in an item from a different file, it is recommended that 
those items either be placed onto a layer that also exists in the destination file, or as an 
alternate, first copy or move the item onto the ArchiCAD Layer, then copy and paste 
it into the new project, after which the items are moved onto the correct layers. Setting 
fills and materials to match those in the destination file is also beneficial, however may 
not always be practical.



STARTING A NEW PROJECT FROM SCRATCH 

 See Part One above for explanation. 



HOW TO TAKE AN EXISTING PLAN AND MIGRATE IT TO 
THE MASTERTEMPLATE SYSTEM

There are two main tasks to accomplish when migrating an existing project into 
your new office standard template. The first one is to synchronize the layers in the 
project to match those in the template. The second is to copy the information (the 
building and annotation) from the existing project file into the new one based on 
the template. 

Migrating a PLN file is straightforward when the project is relatively early in 
development. In the best case scenario, there is a 3D model with annotation on
the floor plans, but nothing else developed beyond what ArchiCAD generates 
automatically in sections and elevations. Migration gets more complex as 2D work 
is done in sections and elevations, markers are placed for detail drawings, and 
details and worksheets are created. It is always possible to migrate a project into a 
template, but at a certain point, the effort may not be worth it.

We suggest that before doing major surgery on your file, you save all your current 
work, and then Save As a copy of the PLN under a new name. In case you do 
something wrong, you can always go back to the previously saved version.

The best way to synchronize layers is to go through the layers you have used in 
your existing project, and rename them one by one to match the names in the 
template. To simplify the process, first create a new MasterTemplate file: File 
menu / New / Use Template / choose MasterTemplate.tpl (or your Office Standard 
Template.tpl) as the template file. I'll refer to this template-based PLN file as the 
"destination file". Next, open up your project in a separate instance of ArchiCAD: 
File / Open / choose your PLN and click "Launch a new instance of ArchiCAD". 

You can then switch back and forth between the two files as you look at and revise 
the layer naming. In the Attribute Manager or Layer Settings dialog, you can copy 
the layer name from the destination file, and switch back to the Attribute Manager 
or Layer Settings in the project file and paste to rename the corresponding layer. 
Be sure to add the "extension" (e.g. 3D, 2D, EXIST, etc.) to the layer name as 
well.

To reduce your work to the minimum, get rid of the layers you have not used in 
your project file by using the Options menu / Element Attributes / Attribute 
Manager. Click the Purge Unused button at the bottom of the Attribute Manager. 
That way you may have only 10 or 20 layers to rename, rather than 50 or more.

Once you've done this (renamed all the layers that have been used to match the 
MasterTemplate naming conventions), you may bring the floor plan and 3D project 
information into the destination file without fear of disturbing the layers, layer 
combinations and Views. 



In the simple case, you've worked on the 3D model and done annotation only on 
the floor plans. You may then simply copy and paste from the original project PLN 
file into the destination PLN.

Before pasting in the model, it's best to adjust the Story Settings in the destination 
file to match the original project settings. 

Next, in your original PLN file, turn on and unlock all layers, draw a heavy marquee 
(the option that references all stories) around the building and site and Edit menu / 
Copy. Go to the destination file, to the corresponding story, and Paste. You may 
adjust the Paste marquee to move the building into a good position relative to the 
existing template setup, or use the Paste into Original Position if needed to 
correspond with external reference files such as surveys.

Once you've pasted in the model and plan annotation, you may adjust the 
elevation and section markers as needed. If there are duplicate markers (e.g. you 
had elevation markers in your original PLN that came in from the paste), carefully 
choose which markers to delete. You may delete the ones from your original PLN, 
and move the template-based destination file markers into proper position, so their 
Drawings already placed on Layouts will show the new model. Or alternatively, you 
may delete the destination file markers, and later go to the Drawings on the Layout 
sheets and using the Drawing Manager, relink them to the appropriate source 
marker.

If you have placed annotation in Elevation or Sections, or created Details or 
Worksheets, this work will have to be recreated, or copied and pasted manually 
from the original PLN to the corresponding View in the destination file. In sections 
and elevations, be careful not to copy 3D elements, as they will paste into the 
destination section or elevation as 2D linework, causing unnecessary duplication 
and possible confusion. To copy 2D elements only, you can use Edit menu / Find 
and Select and choose 2D Elements from the topmost criteria. 

TIP: Be sure to use the option when pasting to "Place Elements in Original 
Location" to make sure that everything lines up the way it should.

Finally, load any libraries that were used with the source file including specific 
project libraries.

Materials and fills may differ between the source and destination files and 
should be checked for consistency by reviewing the file in 2D and 3D to see if 
everything looks correct. 

Here's why there may sometimes be an issue: in the simple case, when Fills or 
Materials in the originating file do not exist in the destination file, and elements 
referencing those Fills or Materials are pasted in, the definition of each Fill or 



Material will be added correctly to the destination file. 

However, if a Fill or Material name exists in both files, the definition will not be 
modified in the destination file. For example, if a material called "Default Wall 
Material" is blue in the originating file, and grey in the destination file, walls that 
were originally blue will become grey when pasted in.

In that case, you will need to either overwrite the destination attribute with the 
one(s) from the originating file, or recreate them manually. You can overwrite Fill 
or Material definitions in the destination file using the Options menu / Element 
Attributes / Attribute Manager. On the right side of this dialog box, select and open 
the source file. Select and highlight any Materials or Fills that need updating in the 
file on the right side, and click the Overwrite button to modify those on the left side. 

NOTE: If the Fills with the same name have different index numbers, then this will 
not work - it will instead overwrite another Fill with the same number. In that 
relatively rare case, you'll have to manually recreate the Fill or Material instead of 
using Attribute Manager.

If some Layouts or Masters have been developed in the source file, these can be 
brought into the destination file using the Project Chooser. In the destination file, 
select from the Project Chooser popup (by pressing the button at the top left-hand 
side of the Navigator palette) Show Organizer. This will open up a double-wide 
version of the Navigator. Press down again on the Project Chooser button, and 
this time select the source project, which will be in the list of "running" projects if 
you have been actively copying information from it. 

On the top left-hand side of the Organizer, choose the Layout Book option. You'll 
then see the Layouts and Masters of the originating file, and can drag these to the 
right-hand side to copy them into the current file's Layout Book.



• EXECUTIVE SUMMARY

Import an existing model (3D and floor plan elements only) into a template:

• Make sure the story settings in the destination template file match those in the 
source file. 

• Delete the modeling slabs in the destination template file, as the source will likely 
have its own base or mesh. 

• It is best to synchronize layer naming between the two files, by renaming all 
layers in use in the source file to match corresponding layers in the destination 
template-based file. (If layer names are present in the source file that are not in 
the destination file, these layer names will be added when elements are pasted 
in, however they will not be correctly managed by the layer 
combinations.  Combinations would require updating to address this.)

• In the source file, turn on and unlock all layers with information that should be 
transferred, then draw a multi-story marquee around entire model. 

• Select Copy, then switch to the destination template-based file. Make sure you 
are on the same story as that which was used during the Copy operation. Paste 
and confirm the corresponding story relationship between the two files. For 
simplicity, place the pasted model in the center of the canvas area so that the 
already placed view port markers will function properly. 

• Finally, load any libraries that were used with the source file including specific 
project libraries. 

• Note that section, elevation and detail markers are brought in, but are now 
unlinked. Placed drawings (on the Layout sheets) can be relinked to these 
markers at this time. Materials and fills may differ in some cases, and should be 
checked for consistency.

• Note: any annotations or manually drawn 2D elements in section or elevation 
viewports will not come into the new merged plan during this operation. You 
would have to go to each View in the source file and use Find and Select to 
choose 2D Elements, and Copy, then go to the corresponding View in the 
destination file and Paste (making sure to choose "Paste Into Original Position").



CREATING A NEW OFFICE TEMPLATE FROM A 
MODIFIED MASTERTEMPLATE

• EXECUTIVE SUMMARY

Process for setting up a new template file based on a completed project.

One way to create an office standard template is to take a project that has been partially 
developed or fully completed, and remove the building geometry and the annotations 
specific to the building, leaving intact the structure and attributes. The advantage of this 
approach is that customization to meet existing graphic standards can be done over a 
period of time on a real project. It can be tested and revised until satisfactory; and only 
at that point be converted into a standard template.

We have developed an optimized approach for how to remove the building and 
annotations from a project PLN file to create a new TPL template file. The steps are 
based on the assumption that the project PLN started from the original MasterTemplate 
or a template derived from it.

• Create a copy of the source project file, then use that copy to complete the 
process below.

• In the Layer settings dialog box or in the Quick Options palette, select the 
Layer Combination '* DELETE MODEL'. (Note: This layer combination locks 
certain visible layers so that important template elements on those layers cannot 
accidentally be deleted).

• Use the Project Map for the next steps:
o Starting on the lowest story, use the Arrow Tool then Select All (Control-A

or Command-A), and delete these elements by using the Delete key.
o Separately delete all Interior Elevation Marks, with the exception of one, 

so that the settings can be preserved. You may have use the Layer 
Settings dialog to manually Unlock the Interior Elevation Mark Layer 
temporarily to allow this, but after deleting all but one mark, re-select the '* 
DELETE MODEL' layer again. 

o Repeat step b for each story going up.

• Using the Project Map, select each Section and Elevation one at a time, and 
move any remaining 2D elements to the side into a temporary holding area.
Delete items that are repeated in this holding area as they are not necessary.
(Note, user may wish to draw temporary polyline boxes in these windows as 
holders for Fit to Drawing placed drawings on Layouts. An alternate to this would 
be to have stories set to display, the full drawing height will then be viewable.



• Using the Project Map, repeat the same for Worksheets and Detail windows.

• Using the Drawing Manager, select all drawings and set to Fit Frame to Drawing, 
then Update All Drawings.

• Open each Layout Sheet and reposition any and all drawings as well as deleting 
or modifying other items placed onto those sheets as required. 

• Finally, modify the Autotext source information in the File Menu > Info > Project 
Information. (Note: we are currently exploring other ways to achieve this using 
an XML file process. 

• Save as a new Template file by selecting File > Save As, then in the Save As 
dialog box Save As Type dropdown box select 'ArchiCAD Project Template 
(*.tpl), then give it a meaningful path and name.

• When starting your next new project, commence by opening this new template 
file from the open file dialog box. 



REMODEL PROJECTS | SETUP & STRATEGY 

• CONCEPTS AND PROCEDURES FOR 
SETTING UP AND MANAGING REMODEL PROJECTS

Remodel projects do not necessarily require separate layers for existing and new 
elements.  In fact, we recommend not using any layers for existing or new conditions as 
described below. This keeps in line with our preference for less layers, 
making project management easier with better work flow. Instead, two separate PLN 
files are established (described below) using the compact list of MasterTemplate 
layers. Additionally, it is recommended that entity ID naming should include the 
characters N for new and E for existing as part of their ID if this data is required to 
be listed or scheduled. (Side-note: additional layers for alternate design schemes can 
temporally exist for the purposes of comparison during the design phases, 
however entities placed on those temporary layers shall be moved to their appropriate 
layer after the final design is solidified).

• ANALYSIS

Until now, users would create an unlinked model representation of the existing 
conditions. A copy of that file would serve at the basis for a separate addition / remodel 
file.  One issue with this approach, as the course of work evolves on the project, new 
information may come to light that would affect both the existing PLN as well as the 
addition remodel PLN.  In this case, the new information would then have to be placed 
in both the existing as well as the addition remodel file with the chance for error or 
conflict. Another issue with this approach is that more layers could be required, 
affecting work flow and management. Finally, there is a real possibility that existing 
entities within the Addition / Remodel PLN may accidentally be deleted or repositioned 
in a way that their original or correct position could not easily be verified.

These concerns are substantially mitigated when the As-Built / Existing PLN is hot 
linked with the Addition / Remodel PLN. The new method outlined below maintains an 
up-datable link from the As-Built / Existing PLN to the Addition / Remodel PLN, 
eliminating the possibility of conflicts between existing and new components. It also 
eliminates the need to have separate layers for new or existing items, facilitating better 
project control, work flow and management.



• EXPLANATION OF THE HOT LINKED METHOD 
FOR ADDITION / REMODEL PROJECTS

Setup your Addition / Remodel project using two separate PLN files. The first or Source 
file being the As Built / Existing building model, with the second being the Destination 
Addition / Remodel Master file. The Addition / Remodel Master Destination file will 
contain both a placed Hotlink Module created from the Source As-Built Existing PLN as 
well as added elements like newly added walls, etc. The As-Built Existing PLN file that 
is used to created a Hot Linked Module can be periodically updated as additional 
information becomes available throughout the building survey process. For instance, an 
ArchiCAD model of the existing field conditions can be commenced based on initial field 
measurements, and further refined later as more detailed information may become 
available. (Note: not all building survey information may have been collected or is 
available at the time the As-Built / Existing ArchiCAD model is commenced).

By separating the As-Built / Existing PLN from the Addition / Remodel Master PLN, the 
As-Built Existing PLN can stand alone as an accurate record of the existing field 
conditions, and can easily be up-dated over time. Because the Hot Linked Module 
within the Destination Addition / Remodel Master PLN is hot linked to the As-Built / 
Existing Source PLN, it will always remain current with that As-Built / Existing PLN.

In contrast, an un-recommended alternate method places all of the existing and addition 
/ remodel information within one PLN. That approach requires adding many more 
layers, and will have an adverse affect on work flow. Further, the accuracy of the 
original building survey could be compromised as work on the model progresses. With 
the stand alone method first described above, the As Built / Existing Source PLN can 
always be independently checked for accuracy and used with a high degree of 
confidence in its accuracy. It is not cluttered or combined with additional elements.

In commencing the Source As-Built / Existing PLN, all items are existing and are simply 
placed on their appropriate layers. For instance, an existing exterior wall will be placed 
on the A | WALL | EXTERIOR.3D layer, and so on. Modeling the existing conditions 
continues to a point when the architect / designer would like to initiate a new model 
representing the addition / remodel. Prior to creating the new second file, the user shall 
select a layer combination (perhaps * CREATE MODULE) which shows the completed 
model for export as the Existing Module. (Note: the A | DEMOLITION.3D layer can be 
included, but it is not recommended as element interaction issues relating to demolition 
items will be eliminated if this layer is excluded from the module).
At this point there are two alternate methods for saving as a Hot Linked Module, with 
the preferred as follows: With the As-Built / Existing model visible in plan view, 
surround it completely using the multi-story marquee, and select Copy from the Edit 
menu. Then in the menu bar select File > Save As, then in the Save As dialog box 
under Save As Type, choose 'Module File from Clipboard (*,MOD). Give it a name and 
select Save. The second method uses the same copy steps outlined above, but instead 
is saved as follows: in the menu bar select File > External Content > Save Selection As 



Module. Here the user needs to make sure the 'Replace Selection with this Hotlinked 
Module File' checkbox remains un-checked.

TIP: Place a polyline around the entire model to help get the Marquee set up 
each time very quickly. With the Marquee tool active in multi-story mode (thick 
marquee line), space-click the polyline, which will trace it with the Magic Wand. 
The polyline should be placed on the A | NON-PLOT layer, but be visible in the 
MODULE Layer Combination.

The next step is to create a new file that will contain both a hot link module produced 
from the As-Built / Existing PLN as well as new items representing the addition. Items 
to be demolished are placed onto the A | DEMOLITION.3D layer in the As-Built Existing 
PLN, and controlled in the new plan.

If in the course of the design phase of the project, a wall or portion thereof may 
be required to be shown as demolished. In that instance, that wall will be moved from A 
| WALL | EXTERIOR.3D onto the A | DEMOLITION.3D layer within the As-Built / 
Existing PLN. The As-Built / Existing model will appear unchanged when the A | 
DEMOLITION.3D layer is visible. It should be noted that there is some back and forth 
between the As-Built / Existing and the Addition / Remodel PLN files

Demolition items are controlled within the As-Built / Existing PLN, and become part of 
the Master PLN via the HLM.  Because Demolition items are all on one layer, they are 
easily isolated for manipulation within a Demolition Worksheet. The procedure includes 
first marquee copying each story onto a Worksheet. In doing so, entities are 
automatically exploded into their primitives, but they maintain their respective layers.
Next, with only the Demolition layer visible, modify those primitives graphically to 
represent demolished items, traditionally with dashed lines and fills, or to your office 
standards if different.

Wall composites or types used in representing new and existing to remain will be 
identical, with the exception of the background fill pen of the core. For the existing to 
remain condition, the background fill pen can be either set to transparent or white, while 
walls for new construction can have the background fill pen set to a traditional poche 
color, like light blue.

For the purposes of auditing or scheduling data, existing to remain, existing to be 
demolished and new entities will be accomplished through the use of the entity's ID.
Therefore, entity placement on a particular layer only affects visibility, and is not solely 
required for cataloging of information. Again, less layers equals better work flow.

It should be noted that if the user desires or has the need to isolate addition or new 
elements within the Addition / Remodel Master PLN, that is easily achieved by selecting 
all new entities and saving them as a module. The visibility of this new module will be 
controlled by one single new layer A | MASTER-MODULE (BLDG. ADDITION).* MOD.



This option gives the user the ability to quickly illustrate the scope of new work 
compared to existing from within one file, however this approach creates additional work 
that produces an arguably unnecessary product.

Tip: for the Existing PLN model, where certain conditions require wall trimming, it 
is recommended to trim those walls to roofs rather than use Solid Element 
Operations in adjusting the wall height. That way Operators do not have to be 
included in the exported Module file.

Separately note that new entities within the Addition / Remodel PLN are able to 
be modified by Existing Module entities through Solid Element Operations.



QUICK GUIDE TO REMODEL PROJECTS

• EXECUTIVE SUMMARY

Two PLN files are used, one for the existing building model, and the second that 
includes a Hot Linked Module to the first, as well as the new addition elements. The 
main purpose of this approach is to significantly reduce the number of layers, thereby 
simplifying control and workflow.

• PROJECT SETUP

1. Create a new project file (PLN) using the ArchiCAD MasterTemplate.
2. Model Existing Building.
3. Save a module (MOD) file using the save selection method (multi-story

marquee).
4. Create a second new project file (PLN) using the ArchiCAD MasterTemplate.
5. In the second PLN, create a new layer called * MASTER MODULE | EXISTING.* 

MOD.
6. In the second PLN, place the module file created in step 3 above. Use the layer 

created in step 5 above to control visibility of that ‘Existing Building’ Hot Linked 
Module.

• PROJECT DEVELOPMENT

1. In the second file, model the addition by adding new elements to the existing Hot 
Linked Module. (Tip: for new 3D construction elements, alter the background fill 
pen such that they stand out when next to existing elements).

2. Identify elements or portions thereof that need to be demolished as a result of the 
new design. (Note: demolition items are manipulated from the Existing PLN).

3. Open the original Existing Building PLN file, place those items to be demolished 
on the A | DEMOLITION.3D layer. (Tip: when precisely defining alignment of 
demolition items with new, temporarily paste new entities from the Addition PLN 
into the Existing PLN, line up the entities to be demolished in the Existing PLN, 
then delete the pasted new items). 

4. Overwrite the original module file from the revised Existing Building PLN, which 
now includes elements placed onto the A | DEMOLITION.3D layer.

5. Back in the Addition PLN (second file), update the Existing Building MOD.
6. The demolition items are now easily controlled by the A | DEMOLITION.3D. (Tip: 

make sure layer combinations are updated so that the demolition layer does not 
interact with elements on other layers).

7. The demolition plan is created in a Worksheet in the Existing Building PLN.



8. Single story marquee and copy the first story that will require a demolition plan.
9. Create a new Independent Worksheet and paste (Note: entities are now 

converted into 2D).
10.Make all layers invisible except the A | DEMOLITION.3D layer (Note: this will 

isolate all items to be demolished).
11. Change fills and line types in these remaining elements to represent demolition 

items per your office standards.

• SUMMARY

The Existing Building PLN is used to create Views of the existing and demolition 
conditions. Those views are imported into Layout Sheets contained in the Addition PLN 
file. The Existing Building file can easily be updated should new information come to 
light, or altered with respect to demolition items as the design evolves.

The Master Addition PLN contains a Hot Linked Module to the Existing Building MOD. 
Any changes to the Existing Building PLN can be updated in the Master Addition PLN 
file, keeping the project current with changes shown in the Existing Building PLN file.

At this point the following representations or Views are available: the existing building, a 
demolition plan for the existing building, and the remodeled building showing new 
elements seamlessly placed onto the existing building.

Finally, should there be an additional requirement to control new elements separately 
from existing in the Master Addition PLN, that is easily handled by placing those 
addition elements as a new module, controlled by a new layer * A | MASTER-MODULE 
(ADDITION).3D. In this case, all combinations of new and existing can be controlled 
from within one file, however this is additional work that produces an arguably 
unnecessary product. This 

Using this approach, layers are kept to a minimum with new, existing to remain and 
demolition items controlled by two module layers. As a result, there is no need to have 
individual layers for each existing and new entities with a longer layer list to manage. 

Another important concept with this method, a stand-alone file documenting the existing 
building model is separately maintained and easily updated. This file is not cluttered 
with addition entities, and can easily be checked for accuracy.

Addition remodel projects have traditionally produced a separate file for the existing 
conditions, but until now that file was unlinked. If after commencing documenting the 
field conditions, uncovered or unknown conditions could come to light requiring altering 
the existing model. In that case, changes would be required of both the Existing Building 
PLN as well as the New PLN. This will not be the case in the method outlined above as 
alterations made to the Existing PLN will be reflected in the Master Addition PLN via the 
Hot Linked connection.



FREQUENTLY ASKED QUESTIONS

• Q: ARE YOU BREAKING THE HOTLINK OF THE MODULE IN THE 
NEW ADDITION PLAN SO THAT YOU CAN EDIT AS NECESSARY? 

A:  No, please do not break the Hot Linked Module in the new Addition file, as that will 
defeat the entire purpose of this approach. You will edit the Existing PLN to address the 
new conditions created in the Addition PLN.

There is some back and forth which goes on between the Existing PLN and the Addition 
PLN. As the addition evolves, you most likely will be required to make adjustments to 
the Existing PLN file. For instance, a portion of a wall (in the Existing PLN) may need to 
become demolished based on the new design (being worked on in the Addition PLN). 
You will need to accurately know where to cut or slice the existing wall (or element) 
based on the new wall (or element) placement. Locating this exact point in the Existing 
PLN is achieved by copying the new wall (or hotspots, lines, roofs, slabs, etc.) from the 
Addition PLN and pasting them TEMPORARILY into the Existing PLN. After pasting the 
new item(s), locate the exact position of the demo items. Slice those existing items and 
place them onto the A | DEMOLITION.3D layer. After this step you delete the 
temporarily placed elements from the earlier step described above. NOW, save the 
Existing PLN as a Module again AND overwrite the original module file. THEN update 
this Hot Linked Module back in the Addition PLN. The updated HLM in the Addition PLN 
will correctly show the existing to remain and demolished items as desired.

Tip: Having both the Addition as well as the Existing PLN files open at the same time is 
recommended during the periods of adjustment as in the example noted above.

Also, in the Existing PLN, your existing plans will display correctly when the A | 
DEMOLITION.3D layer is visible (with the exception that there will be residual lines 
between where the demo items join the existing to remain items). If that is undesirable, 
please draw over these areas with a white pen to hide the joints. The Existing PLN will 
exactly represent the existing conditions, even though some of the entities are placed 
on the A | DEMOLITION.3D layer.



Q: IF I PUT THE DEMOLITION PLAN ON WORKSHEET, THAT IS 
EXPLODED INTO LINES AND IS NO LONGER AUTO UPDATED, (OR IS 
IT?) SO IT TOO WOULD THEN HAVE TO BE MANUALLY UPDATED AS 
I WORK OUT WHICH WALLS/ETC GET DEMO'ED? 

A:  Regarding the demolition plans on a Worksheet, you are correct in that it is not live. 
Changes will have to be made manually, however this is extremely quick and easy, with 
alterations handled within minutes and coordinated through the use of Virtual Trace.



LAYER NAMING, USE & MANAGEMENT 

The primary goals and the underlying principles for the layer naming convention used in 
the Master Template are as follows:

• Provide a list of manageable size to minimize confusion.

• Allow for quick and easy sorting and management of layers. 

• Provide meaningful layers, not just a layer for every possible condition. 

• Provide a framework for logical expansion, but initially start with as complete a 
general list possible for most projects. 

• Names are explanatory using complete words, not cryptic abbreviations. 

• Intuitive usability; when users are faced with placing an entity onto an unspecified 
layer, they will do so intuitively such that those elements will not be misplaced. 

• The end result shall be a logical and understandable grouping mechanism so as 
to make more intuitive the workflow, keeping a minimum of layers. 

• Provide a visually appealing list that leads the user to logical use. 

• Visual consistency with how fills and materials are now represented in their 
respective lists through the utilization of the vertical separator line.

• BACKGROUND

Graphisoft ships ArchiCAD with an abridged set of layers taken from those provided 
from the National CAD System (NCS) and the Uniform Drawing System (UDS). Those 
committee-devised layer names were based on two-dimensional drafting systems, and 
became the primary means for cataloging and displaying drawing information. The 
layer names use alphanumeric coding and cryptic four character abbreviated names, 
with (difficult to read) hyphenated sub-sections.  As an example, drawing primitives 
placed on a layer designated C-SITE-XXXX-YYYY will be seen on the Site Plan and 
available for graphic display as a civil engineering discipline item. As a result, this 
system requires significantly more layers in representing subsets of information than 
necessary in today's BIM environment.

Data management today (for cataloging and auditing purposes) is no longer solely 
dependent on layers, but instead uses other means, freeing layers to be used for their 
primary purpose. That is, in modeling the three dimensional realm rather than to 
additionally cull the data.

Data in the BIM environment is now collected and organized in other ways, outdating its 
predecessor's approach mentioned above. It is now queried primarily through ID 



management in addition to element type. Also, displaying information in conjunction 
with workflow is better handled in the new system, as layers (although they contain 
data) now are primarily used for display purposes. Multiple element types can now 
appear on the same layer if necessary. Further, because doors and windows are now a 
subset of walls (children / parent relationship), those past layers are obsolete, as is 
much of the original system.

It should be noted however that there are some circumstances where, due to a project's 
nature, there could be a requirement for using the outdated layer naming system.
Those fall primarily into the categories of either government, institutional or historic 
preservation projects, where the governing entity may require the electronic files to use 
an approved archaic layer naming system. As a result, an alternate layer naming 
system can be provided that conforms with these special client's requirements.
However, this alternate approach is considered the exception and not the norm when 
considering current BIM practice. It is believed that the responsible professional 
organizations will soon amend their legacy naming system to better address current 
BIM practice.

In light of the above, we have provided a new layer naming (hybrid) system utilized in 
the ArchiCAD MasterTemplate, which incorporates the best that those earlier systems 
offered (that being the basic preface coding for sorting and grouping purposes).
However our new approach goes way beyond coding practice by being simple, 
straightforward, and easy to understand and use. Our new approach uses less layers, 
and thereby facilitates easier management. Projects should only contain the layers 
necessary to achieve the desired result. In this case, less is truly more (as long as it 
addresses all the project’s conditions).



The ArchiCAD MasterTemplate Layer Organization
Overall Structure

In developing the ArchiCAD MasterTemplate layering system, a standard hierarchical 
categorized system similar to those created by the professional and industry groups 
noted above was initially chosen for its sorting capabilities, however it was modified to 
better address the requirements of working in the BIM environment. 

The logic went as follows: In considering three-dimensional building elements (site 
excluded), it boiled down to two nearly equally valid approaches; assembly based and 
tool or surface plane based. The tool-surface plane based approach seemed to be more 
intuitive and thus was selected and developed for this template (I need to draw a ceiling 
slab, so I select the slab tool, the layer of which will be A | SLAB | CEILING.3D). Also 
supporting this concept is that floor slabs on the story above will often act as the ceiling 
for the floor below (in residential construction), so the need to have a separate category 
grouping for ceilings seemed unnecessary in the context of keeping layer quantities to a 
minimum.

Further supporting the concept of keeping lists to a minimum, the ArchiCAD 
MasterTemplate layer combinations feature locking layers when hidden. In doing so, 
pop-up palettes will only display visible layers, thereby limiting the list length, making
quicker and more efficient review when scanning the list. 

In summary, the overall Layer naming organization uses a hierarchical structure of 
prefixes at the first level, then tools (elements), surfaces and/or conditions for second 
level naming, followed by subset conditions if necessary, then finally layer extensions.
Each subset name is partitioned using a vertical separator { | }. Sorting and managing 
this layer list is very simple, and is accomplished using the categories as the list 
headings, including the 'Funnel' filter for extensions. The vertical separator lines 
provide visually assistance when scanning this list, and enhance the process as a 
result.

Finally, the actual list of layers in the ArchiCAD MasterTemplate was developed based 
on actual testing with real projects. Testing occurred primarily using single and multi-
family residential projects, however some commercial testing has also been used.
Although the list has been only partially tested using a commercial building, the layers 
still provide complete functionality. The layers provided comprise a balanced amount 
appropriate and necessary for any small to mid size project. Unneeded layers may be 
purged, and alternate layers may easily be added. It should be noted however that the 
layer combinations which come with the MasterTemplate are set to use those layers 
included, and adding new layers will require manual updating all combinations one at a 
time.



• LAYER NAME PREFIXES TABLE

Layer name prefixes are used for categorizing and are as follows:

PREFIX SORTING GROUP REMARKS

A Architectural

C Civil Engineering

S Structural Engineering

L Landscape

M Mechanical

E Electrical

P Plumbing

U Drawings See extension table below.

Y Special Elements See extension table below.

Z Trash / Recycling & Warnings

ZZ Detailer Items

* A Modules



• LAYER NAME EXTENSION TABLE

Layer name extensions are used for grouping as well as sorting purposes and are as 
follows:

EXT LAYER TYPE TYPICALLY PLACED ITEMS 

3D Building Model Elements, common 
items that typically appear in most 
drawings. 

Walls, Slabs, Roofs, Stairs, Cabinets, 
Moldings, Columns, Beams and 3D 
Objects. 

2D Building Info Elements, semi-common 
items that appear in some drawings, 
which materially add to or describe the 
building. 

Dimensions (if need to separately 
control), Room Names, Drafting Fills, 
Part Symbols and Zones. 

MARK Reference Elements, semi-common 
items that appear in some drawings. 

Section, Elevation, Detail & Interior 
Elevation Marks as well as break lines. 

UNIQ Drawing Elements, unique items that 
appear in one individual drawing at a 
time, which annotate and describe. 
These items can be 2D & 3D and 
describe the building. 

Dimensions (if no need to separately 
control), Labels, Notes, etc. In general, 
any elements specific to, and limited to, 
a particular drawing. 

Y (prefix) Special Elements, special items that 
may or may not be visible, but are 
used to generate the model, data or a 
special view or appearance. Can be 
2D or 3D extensions. 

Solid Element Operators (Hidden), 
Explanatory Text and Prompts and 
Model Part Extras (Visible). 

MOD Control Elements, allows for separate 
control of modules. 

Used to control the visibility of legends. 
Also as an example, individual units 
within an apartment or hotel type 
project. 

DETAILER Detailer Elements, allows for the 
incorporation of that detailing system. 

Refer to Karl’s explanation. 

Z Trash / Recycle & Warning Elements, 
allows for a depository for temporary 
holding of elements prior to permanent 
removal from the project. 

Any elements can be placed onto the 
trash layer.  



EXIST’G Existing Elements, filter & organize 
these elements that otherwise would 
be a part of 2D & 3D extensions. 

Self explanatory. Delete these layers for 
new construction or leave unused.
These layers can be omitted entirely 
in remodel projects when the module 
approach is used.

DEMO Demo Elements, filter & organize 
these elements that otherwise would 
be a part of 2D & 3D extensions. 

Self explanatory. Delete these layers for 
new construction or leave unused. 



• ADDITIONAL CONCEPTS AND ITEMS OF NOTE:

• The use of unique 'U' layers allows for all two-dimensional descriptive information 
relevant to a specific drawing to exist on one layer. Entities that are required to 
be isolated shall not be placed on these layers. For instance, room names would 
not be placed on any of these layers because they are a common entity used in 
many combinations. For discussion purposes, dimensions should validly be 
placed onto a 'U' layer if there is no requirement to isolate them. In some ways, 
dimensions function the same as annotations, describing the building model. In 
conclusion, anything that describes or modifies a particular drawing may be 
placed onto a UNIQ. layer, i.e. dimensions, descriptive text, keynotes, labels, fills, 
or other primitives which are unique to that drawing. 

• All modeling elements have the 3D layer name extension, which is useful when 
sorting and filtering the list. Most of the 3D layers are visible for creating and 
working with the building model or site model. 

• Suggested working method relating to Layers: Print out a list of all layers and 
combinations for quick reference. Use OPTIONS > ATTRIBUTE MANAGER, 
then print to a TXT file, open in Excel, sort and print. You may want to separately 
add the layer extensions in another column as they are not delimited in this 
process. 

• When setting up an addition / remodel project, please refer to that section of this 
document for a complete explanation. However, the following comments are 
appropriate here: 

Layers with the file extension EXISTG are provided, but are really not necessary for 
differentiating between new, existing to remain and existing to be demolished elements.
Those elements can alternatively be controlled through ID management as well as 
graphic representation, and further through the use of modules. New walls can use the 
same composite wall structure as existing walls, but have the background fill pen set 
(overridden) to a traditional blue poche, while existing walls can have their background 
fill pens set to white or transparent. This approach is based on a two file system 
described earlier above, where one PLN contains the Existing conditions including 
demolition items, and the second PLN contains a Hot Linked Module to the Existing 
plan as well as added New elements. Items to be removed shall be placed onto the 
Demolition Layer in the Existing PLN, which is typically switched to Invisible and set with 
a different layer interaction value. Demolition plans are easily created by pasting a copy 
of the floor plan into a worksheet, then by switching the module layer invisible, the 
demolition layer will be isolated for manipulation of elements. Line types and fills are 
easily modified to represent demolished items.

• BIM layering is basically organized into two major groups; modeling and 
annotation (with annotations all being placed on the U | DRAWING layers).
There appears to be no need in a BIM system to segregate 3D 



assemblies/parts by layer for auditing purposes as that is more properly handled 
through ID management, and thereby reduces the need for dedicated layers. 

• If an imported DWG file layer structure must be preserved, a layer extension of 
DWG is appropriate to add (the user could also add a sorting mark like a tilde to 
the beginning of each layer for additional grouping purposes). 

• INSERT HERE: an explanation of how stories and layers interact with each 
other, and note that layers do not stack on top of each other. 



A PLACE FOR EVERYTHING
EXAMPLE LIST OF WHERE ELEMENTS BELONG

(list to be ongoing, please submit your requests on the forum)

LAYER ELEMENT REMARKS

A | MOLDINGS | LOW Lintels over 
openings. 

A | MOLDINGS | LOW -or- A 
| WALL | ACCESSORIES 

Wall Caps. 

Y | SPECIAL | MODELING-
ELEMENTS (VISIBLE) 

Filled in areas like 
walls above roofs at 
dormers. 

Elements that are visible in 3D & 
Elevation but not in roof plan view. 

Y | SPECIAL | MODELING-
ELEMENTS (INVISIBLE) 

Solid Element 
Operators or 
interacting elements. 

Hidden in most views, but turned on 
while creating or editing these elements 
to create effects on other (visible) model 
elements.

A | WALL | ACCESSORIES Applied skins and 
wall treatments 

Like those from Cadimage. 

A | ROOF | FRAMING Roof rafters Manually placed or automatically 
created using RoofMaker. 

A | ROOF | ACCESSORIES Applied roof surface 
skin 

Like those from Cadimage 

A | WALL | ACCESSORIES Downspouts Stand alone like with leader head 

A | ROOF | ACCESSORIES Gutters 

Y | SPECIAL | MODELING-
ELEMENTS (VISIBLE) 

Soil in pots or raised 
planters. 

L | LANDSCAPE | 
ACCESSORIES 

Terra Cotta Pots 

U | UNIQUE | PLAN + 
SECTION + 
ELEVATION.UNIQ 

Building Dimensions 



U | UNIQUE | PLAN | 
SITE.UNIQ 

Site Dimensions 

A | DIMENSIONS Common 
Dimensions 

Those which repeat between multiple 
drawings. 

C | TOPO | HARDSCAPE 
(SLABS & ROOFS) 

Ramps 



Layer Combinations Naming and Use within the 
ArchiCAD Master Template:

l In contrast to keeping the Layers list to a minimum, it seemed correct to 
expand the layer combination list to cover the broad range of conditions, even if 
redundant combinations occur as a result. In that regard, Layer combinations 
were provided for each drawing type possible. That includes both presentation 
as well as contract document drawings. 

l In addition to layer combinations for drawings, additional combinations are 
also provided for other non-drawing conditions. Modeling, Detailing, Layouting 
and * Special. 

l Layer combinations have been set to correctly represent all views 
l Layer combinations include locking hidden layers. This limits only visible 

layers to be available in pop-up palettes, thereby enhancing workflow. 
l Updating layer combinations will be necessary should new layers be added or 

existing layers be modified. The procedure for this is outlined below.

Procedure for updating layer combinations:
(should the addition of a new layer be required)

In the Layer Settings Dialog Box, and with the added Layer selected in the right side 
column, start at the top of the Layer Combination list on the left, select each in 
succession and set the visibility, mode, interaction and locking attributes one at a time.
After all have been set, click OK and exit the Layer Settings dialog box.

Conceptual Layer Combination Table:
The following table illustrates the visibility of different elements as set within layer 
combinations.

Insert Layer | Layer Combinations Matrix here.



Model View Options Combinations Naming, Use & 
Management

Model View Option Combinations are one of the seven settings that make up a View in 
the View Map. And although all seven settings are important in controlling the expected 
outcome of a View, the two most critical are Layer Combination as well as the Model 
View Option Combination settings, with the latter most often being mis-used. The 
importance of this setting is often overlooked and as a result, can be the cause of great 
confusion. That being said, we set out to simplify use of this setting as much as 
possible by providing an intuitive naming scheme. 

In the ArchiCAD MasterTemplate, names for Model View Option Combinations are 
literal and based on the type of View they are associated with. So for instance, a 
CONDOC Floor Plan View will receive a CONDOC | FLOOR PLAN Model View Option 
Combination as well as a CONDOC | FLOOR PLAN Layer Combination. This straight 
forward approach uses the principle of matching names, avoiding cryptic names that 
invariably lead to confusion and possible errors. Note: this is true for most Views, but 
may vary slightly depending on certain Views. 

In the ArchiCAD MasterTemplate, Views, Layer Combinations and Model View Option 
Combinations names closely match each other. Some Model View Option 
Combinations have redundant settings in affect with two different MVO names that use 
the same settings, which produces a slightly longer list of combinations. However, this 
approach facilitates a greater ease of establishing View settings by using matching 
setting names, thereby removing guesswork and improving workflow. 

Of note though is that we have preset Views using the above mentioned naming 
convention. So for most of your work our MVO Combination naming should be fairly 
transparent, however there will be times when custom adjusting may be required. For 
those times our MVO Combinations naming system will greatly assist in workflow ease. 

Finally, should you need a new MVO Combination custom to your specific need, please 
create that combination in accordance with the description found in the ArchiCAD User's 
Manual. 



Project Map Structure | Features
  To be added.



View Map Structure | Features
Simplified View Map Structure and Use: 

Five main categories

1. Imported Reference Documents (Worksheets) 
2. Modeling – Design – Legends 
3. Construction Document Views 
4. Presentation Document Views 
5. Trash Recycle Bin 

• Preset clone & standard views. 

• CD & Presentation sections and elevations predefined. 

• See screen shot image for entire listing provided. 

• Explanation of Clone Folders, issue when deleting a linked view, how to override 
folder settings for a sub-view, stories that appear in a folder but are not used and 
indicated by N/A (STORY). 

• Explanation of why many views have zoom set to 'None.' Also as a result, 
sometimes when changing to different view ports using tool bar or after viewing a 
favorites visual legend, double clicking a view will take the user to the correct 
viewport, but they will have to 'fit to window' to see the information. 

• Views which call Visual Legends are organized to mimic the construction process 
as it relates to the steps in building an Archicad computer model. The views or 
legends are therefore organized as follows:  First assembled are slabs, walls & 
roofs. Second, doors & windows are placed. Third, plumbing fixtures, 
appliances & other mechanical items are placed. Fourth, electrical systems & 
lighting are placed. 



Layout Book Structure | Features
Preset Layout Book Structure: 

• Layout sheets are provided for both simple as well as more complex projects, 
and can be reviewed in the sheet index located on the cover sheets for both sets. 

• Layout sheet numbering provided. The included number systems are easily 
modifiable should the user desire a different system. 

• Choice of two title blocks, narrow & wider version that supports industry standard 
detail grid module. 

• Pre-placed drawings. 

• Pre-defined Subsets. 

• Layout Sheet Tools subset folder includes transferable parameters from several 
placed penset drawings. Parameters to be picked up are pensets, title types and 
scale, all in various combinations. This is handy for situations where converting 
back to a default setting is desirable where placed drawings may have been 
accidentally altered. Also, Control or Command Dragging of pre-defined layout 
sheets is available for adding new layout sheets to the set. 

• Pre-set Master Layout Sheets with Autotext, standard, grid and grid/columns for 
various sizes. 



Interactive Visual Legends
1. Start-Up Visual Legend Module included

2. Example provided, user to further enhance per offices standards. 

3. Elements within the visual legend like roofs and slabs are intended to provide 
the composite structure and basic defaults including layer and materials. The 
final materials must be controlled by the user. Similarly for roofs, alt-clicking on a 
roof will provide the composite structure and defaults as well as a 4:12 pitch. It 
will up to the user to define the actual roof pitch. The reason for this is that there 
would be too many combinations of pitches, materials and composite structures 
to represent in a small legend. We chose the most important aspect (composite) 
as well as most common defaults.

4. Legend Descriptions:
A. 3D Wood Frame Composite Structures Legend: for wall, slab and roof 

construction (first steps in building a model). Also may include finish floor/ 
topping slabs. 

B. 3D Window & Door Legend: includes each type of door & window at a 
generic scale, and a description for applying the Parameter Transfer 
technique. 

C. 3D Mechanical Systems Legend: objects including appliances, plumbing 
fixtures, HVAC eq, duct runs & drainage piping. 

D. 2D Annotation Legend: includes dimensions, text, labels, fills, markers 
perhaps (describing the building for condoc output). 

E. 2D-3D Electrical Systems Legend: includes 2D control symbols as well as 
3D electrical & lighting fixtures. 

F. 2D-3D Site Development Legend: includes 2D landscaping for condocs, 
and 3D for modeling ie cars, mesh maybe (discourage placing high 
polygon count trees, but can include if required). 

G. 3D Scene Population: includes non-fixture items that embellish the model 
for presentation.

5. How to manitain and/or create your own.

6. Format and size was selected so as to easily be readable within the typical 
viewing area of most workstations.



PRE-SET INTERACTIVE SCHEDULES 

• Importance of ID management, and how to control. 

• Schedules look to the ID in filtering the information. As a simple example, all 
plumbing items that have an ID that starts with ‘P’ will be included in the 
schedule. Everything else will be excluded. 

• Automatic object labeling & how to control. 

• Editing within the schedule. 

• Document > Schedules & Lists > Element ID Manager for mass changes and 
control. 

 



PRE-SET AUTO TEXT | PROJECT INFORMATION 

• In File > Info > Project Info, fill in all fields that have *** Name ***. 

• How do you know that a text box contains Autotext. 

• Don’t try to edit an auto text box from the text box, instead edit from the File 
menu. 

PRE-SET SECTION & ELEVATION VIEWPORTS 



Pre-set Milled Rafter Tail Feature
The following describes how to achieve custom milled rafter tails using the Milled Rafter 
Tail feature in the ArchiCAD MasterTemplate in conjunction with Solid Element 
Operations.

Located in the Profile Manager is a handy tool for making custom milled rafter tail ends.
The procedure for creating these elements is as follows:

1. Select the AMT Rafter Tail profile from the Profile Manager. Go to Design > 
Complex Profiles > Profile Manager, then select Choose Profile where you then 
select * AMT Rafter Profile. Note that the provided profiles are for 8" thick tails.

2. Delete the example profile used as a place holder.
3. Select the fill tool and Magic wand the desired profile.
4. Drag the top left corner of the selected fill to align with the hotspot at the graphic 

pitch scale.
5. Then rotate the selected fill from the hotspot dragging left to the desired pitch.
6. Store the newly created profile.

At this point you have two choices for creating rafter tails as follows:

Option One:
1. Option One: create rafters using the Roof Maker Tool located in Design > Design 

Extras > Roof Maker. Select one or more roofs, then using the Roof Maker Tool, 
select Roof Wizard to create rafters based on design criteria you input.

2. In a Section window and with all rafters grouped, adjust the vertical position of the 
rafters to the correct height.

Option Two:
1. Draw slanted beams at 8" high and at desired width to match pitch..

Next:
With the wall tool set to use the complex wall profile created earlier and placed on 
the Y | SPECIAL | MODELING-ELEMENTS (SEO-INVISIBLE).3D Layer, draw a 
profiled wall along the eaves in contact with the angled beams or rafter tails. Make 
sure all the segments are grouped.

2. In any available section view port, select the profiled wall group and align with the 
beam ends.

3. Use the Solid Element Operation feature to subtract the Target beams from the 
Operator complex profiled walls. Make sure that "new surfaces of target use their 
own attributes" is checked.

4. Although we have set this in advance, the layer intersection group value must be 
something other than the value for other layers with walls on them, or else the two 
layers may have an undesirable interaction.

 



Detailer Setup & Use
Integration of the Detailer system and use (refer to Karl Ottenstein’s doc, see hyperlink 
below). 

A. Includes Detailer tracing template as a preplaced object in Detail Window. 

B. Includes Detailer snapping object preplaced onto Master Layout Sheet. 



User Required Management | Checklist
Tasks user is required in adjusting template to fit a specific project: 

1. The first time template is used, insert office standard items like company name, 
seal, etc. onto master sheet. Insert boilerplate notes and other office standards 
onto the Title layout sheet. 

2. Enter project specific auto text. 

3. Adjust story levels. 

4. Adjust modeling slab relative to project zero and project limits. 

5. Adjust limits of section and elevation marks, and distant area depths. 

6. Adjust frame of placed drawings on layout sheets. 

7. Adjust location of placed drawings on layout sheets based on project scale. 

8. Adjust size and position of placed schedules as these will increase in length as 
entities are added to the project. The same goes for the Sheet Index list placed 
on the title sheet. 

9. Select & control types of drawing titles used (if alternate is desired). 

10. Adjust title layout sheet indexes and drawings as required. 

11. Add project specific layers, if necessary. 

12. Control the object label check box for objects not requiring an attached 
label.

13. Template Use Checklist, sequence of use (after initial setup).

A. Fill in project information from File menu. 

B. Set number of stories and relationships if required. 

C. Delete unneeded Layout Sheets. 

D. Rename or add story levels if required. 

E. Set story levels to display project specific absolute or relative levels.



Working Methods | Standard Practices in ArchiCAD
Stacking Drawings in Layout Sheets:

In the same way Virtual Trace allows the user to see the current view overlapping 
another related view, stacking drawings on a layout sheet achieves a similar result, and 
for similar reasons. Although ArchiCAD 11 allows you to print from the model area and 
include a Trace Reference, you cannot do the same when printing or plotting a layout 
sheet. However you can achieve the equivalent by overlapping or stacking drawings.
Further, because every drawing can have its own penset, one of the overlapping 
drawings can have a faint or faded out penset (all light grey for instance) simulating a 
traditional background effect.

A couple popular uses are when the user needs certain information to stand 
out next to background information, like in either an electrical or lighting plan.
Also, overlapping an existing survey with a modified can sometimes be 
beneficial. Finally, structural systems standing out against the background 
floor plans.

Tip: when stacking drawing described above, change the drawing 
title to 'No Title' for one of the two stacked drawings, typically the 
background drawing.

Parameter Transfer Technique
This is used primarily in two situations; for updating older version library parts to current, 
and in windows or doors where the same or similar parameters are desired to be 
consistent between two different types of doors or windows. 

The following describes the process:

1. Eyedrop any library part element (door, window or object) in your plan to pick up 
its settings.

2. Next, select either the single object or all objects that you desire updating.
3. Open the object settings dialog box (Command or Ctrl-T) and browse to find the 

object, door or window that you want to use to replace the selected item(s).
4. Then syringe (Alt Ctrl Click or Command Option Click) the settings into the 

thumbnail preview in the lower left area of the dialog box for that new object, door 
or window.



In the case of doors and windows, all matching parameters will be transferred so 
that the new object, door or window will be set to the same size as the one you 
eye-droppered, and if the parameter names are the same, the trim size and 
material and other stuff will also now match. Click OK and the new window will 
replace all of your selected window(s).

In the case of updating an older object from an earlier library, the user will browse 
in the settings dialog box from the absorbed parameters library (an earlier version 
typically) to the same part within the current library, and inject as described above.

• ID Management 
o Explanation...in cataloging data in schedules, and working 

procedures/methods. 

• Creating and Maintaing Visual Legends Module files 
o Explanation...(which are catalogs of user's office standards. Note that 

separate module files can be created for walls, etc, then placed 
overlapping each other, controlled by separate master layers to 
consolidate views). 

• Procedure for selecting or modifying Complex Profile Milled Rafter Tail 
Operators. 

• Procedure for creating Sheet Indexes with Segmented Subsets 
o Explanation...setting up...advanced users only. 



A.
B.



Hyper Links to Other Important Explanations
Hyper-links to popular Architalk & ArchiWiki tips and tricks and AEC Bytes articles. (to be inserted 
into the help folder by the user and is a separate to be completed document)

• Penset Stratagies (ArchiCAD Wiki)
• Detailer (Karl Ottenstein)
• Clone Folders
• Hot Linked Modules 
• Parameter Transfer for Older Windows
• Layer Update Trick (James Murray)
• The Link Collection
• Team Leader in Teamworks
• Monthly Winning Tech Tips
• ArchiCAD BIM Experience Kit
• Detail Catalog Explained
• Sheet Index, basic explanation
• Common Dimensions on Multiple Stories (Karl Ottenstein)


